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Introduction 
Sure you can click your way through ribbons, palettes, and dialog boxes, but as any truly 
proficient user of any program will tell you, one of the keys to becoming a power user is to find 
ways of getting things done faster, with the fewest number of clicks and picks. The following 
collection of tips is designed to help you achieve that goal—in Revit. 

Here are 20 Revit tips, in question and answer format. Although these tips are based on Revit 
Architecture 2011, most are applicable to other flavors and earlier versions as well. 

Tip #1: Making Roof Lines Visible in Floor Plans 
Q: How do you make a roof overhang appear as a hidden line in a floor plan for a level below 

the roof? 

 
A: There are several solutions to this, but I think this is the easiest method: 

1. Open the plan view of the level in which you want to see the roof line. 

2. In the view properties, expand the Underlay drop-down and select the level on which the 
roof was created to display as an underlay. This makes the roof line visible in the plan 
view, but the lines appear as solid lines. 

3. Select the Linework tool in the View panel on the Home ribbon. Revit displays the 
Modify|Linework contextual ribbon. Select the desired linetype from the Line Style type 
selector. 

4. Click on each roof edge line to change the linetype. 

5. Go back to the view properties and change the underlay back to “None.” 

Tip #2: Working with Imported CAD Files 
Q: Why is it that sometimes when you import a CAD file 

for use within a drafting view, you can’t select the file 
and move it to the foreground or background? 

A: When importing a CAD file (such as an AutoCAD 
drawing) for use within a drafting view, in order for 
the file to be visible in the drawing view it should be 
imported or linked to the Current View Only. If you do 
this, you will be able to move it to the foreground or 
background by selecting it and then choosing the 
desired option on the Options bar. When importing a 
CAD file to use as the basis of a site plan or topo, however, be sure the Current View Only 
check box is NOT selected. Otherwise you won’t be able to select the drawing for use in 
creating a topo surface.  
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Tip #3: Tag Doors by Type/Tag Windows by Mark 
Q: How do you tag doors by Type rather than by Mark; or tag windows by Mark rather than by 

Type? 

A: The information that appears in a door or window tag, as well as the appearance of the tag 
itself, is determined by the Revit annotation family object used to tag the door or window. By 
default, door tags appear as an oval with the Mark (door number) centered in the tag, while 
window tags appear as a hexagon with the window Type centered in the tag. In order to tag 
doors so that the Type appears in the tag rather than the Mark, or to tag windows so that the 
Mark appears in the tag rather than the type, you need to load a different annotation family 
component and use it instead. It just so happens that Revit Architecture comes with an 
alternate window tag that does just this. For doors, you’ll need to create a new tag that uses 
the Type rather than the Mark. But this is quite easy to accomplish. 

1. Open the existing door tag by in the Revit library. 

2. When the tag opens in Revit’s family editor, select the label. 

3. In the Label panel of the Modify Label contextual ribbon, click Edit Label. 

4. In the Edit Label dialog, select the Type Mark category parameter and add it to 
the label parameters and remove the Mark parameter from the label parameters. 
Then click OK. 

5. Save the new annotation tag as a new Revit family component, giving it an appropriate 
name (such as Door Tag by Type Mark.rfa) and click Save. 

6. To use your new tag, load it into your project. 

That’s all there is to it. 

Tip #4: Absolute and relative elevations in Revit projects. 
Q: How do you set the zero level in a project and display absolute elevation levels? 

A: First, set the true project elevation by doing the following: 
In the Project Location panel of the Manage ribbon, click Coordinates>Specify Coordinates 
at Point. Click a fixed point in your project (in a view that shows the elevation), and in the 
shared coordinates dialog, enter the known elevation (the number). Then, in a view showing 
the elevation (such as an elevation view), select the level label to display its properties in the 
Properties palette and click Edit Type. In the Type Properties dialog, under Constraints, 
change the Elevation Base value from 
Project to Shared, and click OK to close 
the dialog box. The elevation labels will all 
change to show the true (absolute) 
elevations. 
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Tip #5: Splitting Faces 
Q: How do you split a façade into multiple colored faces? 

A: You can use Split Face on any non-family instance. The Split Face 
command splits the selected face of the element; it does not change the 
structure of the element. After splitting the face, you can use the Paint 
command to apply a different material to this section of the face. 
For example, to split a wall to apply a different paint color around a 
window, you can do the following: 

1. In the Geometry panel of the Modify ribbon, click Split Face. 

2. Place the cursor on the element face to highlight it. You may need to press TAB to select 
the desired face. 

3. Click to select the face. 

4. Sketch the face area to split. Note that the sketch must form a closed loop inside the 
selected face, or an open loop that ends on the boundary of the face. 

5. Click Finish Edit Mode. 

You can then use the Paint tool (also located in the Geometry panel of the Modify ribbon) to 
apply a different material to the face of the area you split from the rest of the face. 

Tip #6: Schedule areas of non-closed spaces in Revit 
Q: How do you schedule areas of non-closed spaces? 

A: Use the Room Separation tool on the Room and Area panel in the Home ribbon to draw lines 
enclosing spaces that are not separated by walls. Such “rooms” can then be scheduled and 
their areas calculated. Remember that you can use the Visibility/Graphics controls to hide 
the room separation lines. 

Tip #7: Common labels for multiple rooms in Revit 
Q: Maybe a wall actually represents a movable partition. How do you place a single label for 

multiple rooms in Revit? 

A: If you want a group of rooms to appear as a single room in Revit, modify the element 
properties of the walls that should not actually separate the rooms, so that they are no 
longer Room Bounding. Revit will then ignore those walls when placing Rooms. Note, 
however, that if you later go back and make any of these walls Room Bounding, the Rooms 
and room tags that you previously placed will apply only to one of the rooms. 

Tip #8: Changing the eye level height in a Revit walkthrough 
Q: How do you change the eye level height in a Revit 3D walkthrough? 
A: When you initially create the walkthrough, Revit 

assigns one global eye level height for all of the 
keyframes. After initially creating the walkthrough 
path, however, select the walkthrough, switch to an 
Elevation view, and in the ribbon, click Edit 
Walkthrough. Then, on the Options bar, from the 
Controls drop-down, select Path. You can then move 
the individual key points of the walkthrough, including 
changing their elevation. After moving a key point, 
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remember to switch back to the camera and realign it so that it remains targeted on the 
appropriate area in your model. 

Tip #9: Creating sloped walls in Revit 
Q: How do you create a sloped wall in Revit? 

A: There are several ways to create a wall that diverts from the vertical axis. For example, you 
could create a curtain wall, create the wall as an in-place family, use the Wall by Face 
function, or use wall sweeps and reveals in the wall definition. Here’s a quick method for 
creating a sloped wall as an in-place family using a solid sweep: 

1. In the Build panel on the Home ribbon, choose Component>Model In-Place. 

2. In the Family Category and Parameters dialog, choose Walls. 

3. In the Name dialog, assign a name to the new wall you are creating. 

4. In the Forms panel of the Home ribbon, choose Solid Sweep. 

5. In the Sweep panel of the Modify|Sweep contextual ribbon, click Sketch Path and then 
sketch the path of the wall in plan view. Click Finish Edit Mode when done. 

6. In the Sweep panel of the Modify|Sweep contextual ribbon, click Edit Profile. In the Go to 
View dialog box, select the view in which you will define the profile, and then click Open 
View. 

7. Use the tools in the Draw panel to define the profile of the sloping wall. Be sure the 
sketch forms a closed loop. Click Finish Edit Mode when done. 

8. On the Modify|Sweep contextual ribbon, click Finish Model to complete the in-place wall. 

The wall now behaves like any other wall, including the ability to host doors 
and windows, although windows and doors inserted into sloped portions of 
walls may not align with the wall and may therefore need to be modified. 

A problem with “in-place” walls is that they lack the structure of standard Revit 
walls. To create sloped walls that include this structure, first model the shape 
of the wall using mass objects and then use the Wall by Face function to 
convert the faces of the mass into Revit walls. 

Extra Tip: Remember that to ensure that windows slope to match their host 
walls, open the window in the Family Editor and in the Properties palette, 
clear the Always Vertical check box. 

Tip #10: Revit’s built-in calculator 
Q: Is there a way to perform calculations while entering distances and angles in Revit? 

A: Yes. Revit actually has a built-in calculator that you can use at any time while entering 
distances or parameters. To use this “hidden” feature in Revit, simply preface the distance 
or parameter you are entering with an equal sign (=), and then enter the formula. You can 
use any standard arithmetic formula. For example, to create a wall half of 32’-6 7/8”, enter 
the distance as =32’6 7/8 / 2. 
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Tip #11: Plan regions 
Q: Is there a way to show multiple levels within one floor plan 

view? This would be very useful for showing split level 
plans, or showing the roof of a portion of a building that is 
several stories below the level of the current plan view. 

A: Yes. This is exactly the purpose of Revit’s Plan Region 
command. The Plan Region tool (found in the Create panel 
on the View ribbon) lets you sketch a closed region that 
has its own View Range controls separate from those of 
the rest of the plan view. 

1. Open a plan view. 

2. In the Create panel on the View ribbon, expand the Plan Views split button and click 
Plan Region. 

3. Sketch a closed loop using lines, rectangles, or polygons. 

4. In the Properties palette, click Edit. 

5. In the View Range dialog box, specify the primary range and view depth for the plan 
region. Then click OK. 

6. In the ribbon, click Finish Edit Mode. 

The area within the plan region will display based on the view range assigned to that region. 

Remember, a plan is simply a horizontal cross section. The Plan Region tool lets you jog the 
horizontal cross section. 

Tip #12: Modifying cut boundaries 
Q: Is there a way to change the linework that Revit creates when you cut cross 

sections? 

A: Yes. This is exactly the purpose for the Cut Profile tool (located in the 
Graphics panel of the View ribbon). For example, when you create a cross 
section through a building with a sloped roof, Revit shows a basic junction 
between the top of the wall and the roof, but that junction probably doesn’t 
look exactly the way it should. You can use the Cut Profile tool to modify 
the appearance of this junction. Note that you aren’t actually changing the 
model, just altering its appearance in the particular view. Here’s how it 
works: 

1. After creating the section, click the Cut Profile tool. 

2. On the Options bar, select either Face or Boundary Between Faces. 

3. Hover over what you want to edit until it highlights, and then click to select it. Revit 
switches to sketch mode. 

4. Using the sketch tools, sketch the change you wish to make to the profile. Note that the 
lines you sketch must connect to the original profile. You can also control what gets 
added or subtracted from the original profile by controlling which side of the lines you 
wish to keep. When finished, click Finish Edit Mode. If the results are not what you 
wanted, you can select the cut profile and then click Edit Sketch to go back into sketch 
mode to make additional changes. 
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Tip #13: Modifying Revit wall assemblies 
Q: Is there a way to have a portion (one or more layers) 

in a compound wall extend beyond the bottom or top 
of the wall? For example, I’d like to have the 
sheathing and siding extend beyond the sill plate 
extend down to cover the floor joists? 

A: This can definitely be done. The key to making this 
work is to modify the structure of the wall in a 
section view. You must also unlock the constraints 
that normally cause all of the layers to end at the 
bottom of the wall. For example, we want the 
sheathing and siding to extend 1’-0 ½” beyond the 
bottom of the wall to cover the subfloor, 2x10 floor 
joists, and 2x10 ledger and overlap the foundation 
approximately ¾”. Here’s how to do this: 

1. Select the wall you want to modify. Then, in the 
Properties palette, click Edit Type. 

2. In the Type Properties dialog, under Construction, click the Structure Edit button. 

3. In the Edit Assembly dialog box, make sure the preview is turned on and switch to a 
section view. Zoom in to the bottom of the wall. 

4. Click Modify and then select the bottom of the layer you want to be able to extend (for 
example, the clapboard siding). Once selected, click to unlock the padlock icon. Repeat 
this step for any other layers you want to be able to modify. When finished, click OK to 
close all of the dialog boxes. 

After making this change to the wall assembly, you can modify the bottom of an instance of 
the wall by displaying a section view and clicking on the wall. You will notice new grips at the 
bottom of the wall that allow you to offset the bottom of the wall. In addition, if you display 
the Instance Properties for the wall, you will notice that you can specify a Base Extension 
Distance to set the distance that the layers extend beyond the bottom of the wall. 

Tip #14: Creating a roof ridge cap 
Q: How can you create a ridge cap for a roof in Revit? 

A: There are probably several different methods, but one of the most direct ways to accomplish 
this is to create a fascia profile (a section view of the ridge cap) and then apply that profile 
as a fascia. Because of the variations in slope, you would need a different profile for each 
roof slope (although there may be solutions to this problem as well). Here’s a quick step-by-
step: 

1. Open the family editor using a profile family and create a profile for the ridge cap. 

2. Save the profile and load it into the project in which you want to place the ridge cap. 

3. Create a new fascia type using the profile you just created. 

4. Add the new ridge cap as a Roof Fascia. 

You can add similar caps as hip caps. After adding hip caps, you may need to modify the 
mitering at the corners of the roof. 
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Tip #15: Using filters to adjust views 
Q: Is there an easy way to indicate fire ratings of walls in plan views? 

A: Yes. Perhaps the easiest way to do this is to set up view filters that display rated walls using 
different colors, fill patterns, or linetypes. And remember that parameters are case-sensitive. 

Tip #16: Complex Linetypes 
Q: Is there any way to create custom linetypes in Revit similar to those in AutoCAD that 

incorporate text and symbols in the linetype definition. 

A: Linetypes in Revit can only consist of sequences of dashes, dots, and spaces. But you can 
work around this by creating a “Line Based” family. Create these using either the Generic 
Model line based.rft template file to create a Model Line or the Detail Component line 
based.rft template file to create a Detail Line. Both achieve the desired results, so the choice 
of template depends on your specific needs. 

The “line based” family templates include a Reference Line with a Length parameter 
assigned to it. This is what enables you to later draw a line using this family. To create this 
family, I added nested annotation families, snapped to the reference line, created an array, 
added a starting and ending offset parameter. I then added parameters to control the array 
and a parameter called spacing that controls the distance between each symbol. 

 
(Thanks to Paul Aubin for this wonderful tip.) 

Tip #17: Using shortcut keys 
Q: I’m used to typing in AutoCAD. Can I type in Revit to get things done more quickly? 

A: Absolutely. If you press the ALT key, Revit displays letters and numbers associated with 
different commands and areas of the ribbon. You can type those letters or numbers while 
pressing the ALT key to start that command. So ALT+M would switch to the Modify tab. 
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Revit also has many keyboard shortcuts. You can see many of these shortcuts in various 
dialog boxes. For example, if you click Snaps (in the Settings panel of the Manage ribbon), 
the Snaps dialog shows the keyboard shortcuts for the various object snaps. 

You can also modify the keyboard shortcuts. To do so, choose Keyboard Shortcuts in the 
User Interface split button (located in the Windows panel of the View ribbon) to open the 
Keyboard Shortcuts dialog. Complete instructions for modifying keyboard shortcuts can be 
found in the Revit help file. 

I don’t recommend memorizing all of the available shortcuts, but some worth remembering 
include: zoom to fit (ZF), visibility graphics (VG), and render (RR). 

Tip #18: Tear-away Ribbon Panels 
Q: I hate having to constantly switch ribbon tabs. Is there an easier way? 

A: Yes. Individual ribbon panels can be torn away and then remain visible as a floating panels, 
regardless of which ribbon is active, similar to the old toolbars in AutoCAD. And when you’re 
done using a floating ribbon panel, you can easily restore it to its original position by clicking 
the Return Panels to Ribbon button. The panel will return to its original position regardless of 
what ribbon is currently visible. 

 

Tip #19: Adjusting Project North, True North, and Plan Orientation 
Q: How can I make West be Up in my drawings? OR North is Up in my drawings but it’s not 

“really” North. What’s the difference between Project North and True North? OR How do I 
get my project located to match my survey? 

A: Each Revit project file has its own internal coordinate system which by default is only known 
to the project. If your project is a stand-alone, you may be able to live with this internal 
system. By default, North is toward the top of the project and truly faces north. 

When you first start a project, you should specify the project location using either Internet 
Mapping, the nearest major city, or latitude and longitude so that you can generate location-
specific shadows if necessary. Note that you can add new cities to the list by editing the file 
SiteAndWheatherStationName.txt. (If you don’t have actual survey data, Google the latitude 
and longitude for the city you want to add.) 

If you’ve started modeling your project before you locate the project, you probably started 
modeling with the long dimension of the building running left-to-right and no regard to where 
True North is located. That’s okay. You can rotate True North by switching to the Manage 
tab and in the Project Location panel, choosing Position>Rotate True North. Note that the 
project orientation must be set to True North in order to do this. This will change the angle 
for a project relative to True North. You can then specify an angle on the Options bar or 
rotate graphically. 

You can then add a north arrow to your view. The arrow will point toward the top of the view, 
which is now set to true north. If you then change the project orientation back to Project 
North, the building will once more align with its long dimension running left-to-right, and the 
north arrow pointing to true north. 

If you subsequently rotate project north to reorient the model in relation to the view, 
however, the north arrow will no longer be pointing in the proper direction. To fix this, switch 
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the view orientation back to True North, fix the direction of the north arrow (either rotate the 
existing arrow or delete it and add a new one), and then switch the view orientation back to 
Project North. 

In terms of placing your project to match survey data, there are a number of ways to do this. 
If you receive a CAD file with accurate survey data, you can link the CAD file, move it under 
the project to match your project model, and then Acquire Coordinates from the CAD file. If 
you simply receive survey data for a datum point in your model, you can choose Specify 
Coordinates at Point (in the Position split button in the Project Location panel of the Manage 
ribbon; see Tip #4) to accurately locate the building. 

Tip #20: Using the ViewCube 
Q: Constantly switching between views takes a lot of time, and then I have a bunch of views 

open. Is there an easier way? And how do you produce 3D sectional cutaway views? 

A: The ViewCube is a tremendously useful tool in Revit. With the ViewCube, you can spend 
most of your time working in a 3D view as you model, instead of having to constantly switch 
between plan views and elevation views. 

For example, you can quickly jump to an elevation view by clicking on one of the faces of 
the ViewCube. You can also right-click on the ViewCube and reorient the 3D view to any 
existing view. 

You can also use the ViewCube to quickly create great 3D sectional cutaway views that cut 
your model exactly where you want. First, use the Section tool to create a cross section 
where you want to cut the model. Then, make a new 3D view and rename it. Finally, with 
that 3D view active, right-
click on the ViewCube and 
reorient the view to your 
section view. The 3D view 
will match the section 
exactly. You can then spin 
the model to any angle you 
wish. To hide the crop box, 
you can select it, right-click, 
and choose Hide in 
View>Elements. 

More Tips and Tricks 
Do you want more tips and tricks? 

 Pay attention to what Revit tells you in the alert and warning dialogs. 

 Don’t try to force Revit to model things that it can’t quite manage. Remember that plans, 
sections, and elevations just need to look correct at the scale they’ll be placed on your 
sheets. 

 Don’t be afraid to mix the best of Revit with the best of AutoCAD or AutoCAD for 
Architecture and to use other tools in conjunction with Revit. 

I am always looking for more Revit tips and tricks. Please share your best Revit tips and tricks 
with me. Contact me at david@dscohn.com. 

And watch my Revit blog for more Revit Tips & Tricks: http://revit-up.blogspot.com. 
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1. BEGIN WITH SMALL-SCALE PILOT PROJECTS

If you are used to using other BIM software and are trying to transition to 
Autodesk Revit or are beginning with BIM design, you need to sharpen 
your learning curve. Don’t focus on advanced tools from the beginning. 
Instead, start with small scale projects and expand the scope, gradually.

Once you are acquainted with basic features and have set up your hands 
on your pilot templates, start leveraging advanced tools and features such 
as:

• Data and image visualization
• Virtual/Augmented reality technology
• Cloud backups and cloud-based tools
• Data sharing between different teams

Create a bundle of pilot projects and 
keep playing with your models to 

improve your success rates and handle 
issues and failures. Nurture your projects 

and create a standard template that 
would help you quickly learn the nuances 

of BIM modeling over the years.

5www.united-bim.com



Several equipment manufacturers and independent resources have started 
providing Revit-compliant and ready-to-use components that can be embedded 
in your BIM drawings. Though this saves time, you should not depend on such 
components when you are starting. These components are created by 
unassuming manufacturers who might not understand your project and work 
scope.

Most often, these are not built using the same benchmarks you are used to. This 
can lead to inconsistencies in the BIM model. Also, many times these free 
resources are locked for customization, transforming your model into something 
that you don’t want. So, always beware of the free resources and think several 
times while adding a component in a BIM drawing, even when it seems simple.

2. DON’T JUST LATCH ON FREE COMPONENTS

6www.united-bim.com



Keyboard shortcuts can save you a lot of time. If you are thinking to 
build a long-term career in the BIM industry, you need to learn the 
default Revit shortcuts by heart. As these shortcuts help you execute 
many useful commands, keeping them on the tips of your hand will 
help you speed up things.

Also, use custom command and shortcut feature of Revit to build your 
own command. You can do so by heading over to User Interface Tab 
and finding a command to assign a shortcut to it. Here are some useful 
shortcuts to get you started:

3. LEARN KEYBOARD SHORTCUTS

• Use SPACEBAR during placement to Flip/Rotate an object
• Hold SHIFT key while executing a command to toggle 

orthogonal constraints
• Press ENTER key to repeat the last command you executed

7www.united-bim.com



One of the biggest problems beginners face using Revit is to exercise control 
over the objects they select while working on a crossing selection or window 
with a mouse. Revit offers several selection methods to control the things you 
want to select. One can use dedicated tools available at the bottom-right of the 
screen.

4. ACE YOUR OBJECT SELECTION SKILLS

• Select Links: You can turn this off to ensure you don’t select a link 
mistakenly

• Select Underlay: Turning this off would lock the underlay element in its 
position

• Select Pinned Elements: Turn this off when you don’t want to unpin an 
element or investigate an element’s properties.

• Filter: Use this button to avoid selecting elements by mistake.

8www.united-bim.com



Tackling the accidental double click issue on a component 
family is essential for a beginner as it takes the user to the 
family editor. To avoid this scenario, one should slow down 
the mouse click speed or adjust internal Revit settings to 
change the way double-click is treated. To do this, one can 
go to the User Interface Tab and change the preferred 
Double Click option for family out of the below-mentioned 
options:

• Edit Type (Preferred for Beginners)
• Do Nothing
• Edit Family (Default but not Recommended)

5. AVOID ACCIDENTAL DOUBLE-CLICKS

9www.united-bim.com



Revit® allows multiple individuals to work on a single model at the 
same time. You should make use of this feature to accelerate the pace 
of model development.

This will save your model on the network server. When a user opens 
the model, it automatically gets saved to the local system and both 
local and networked models get synchronized every 30 minutes.

6. ENABLE WORKSHARING

To enable work sharing you need to head over to:

Collaborate -> Manage Collaboration -> Collaborate

10www.united-bim.com



By default, Revit saves 20 backup copies of any model in case 
of any problem or data disaster. You should never lower the 
number of backups as this will help you restore data in case 
of an emergency.

7. NEVER MEDDLE 
WITH BACKUP SETTINGS

11www.united-bim.com



8. TAKE FULL ADVANTAGE OF 
MODEL LINKING & CLOUD-BASED 
WORKSHARING SYSTEM

Revit® allows linking models developed by third-party 
consultants to a central model. These models are 
updated whenever you receive a new version. You can 
also import and link models with different file formats 
such as .DWG i.e. used by Autodesk.

Also, if you don’t have a networked server for storing the central 
model, you can use Collaboration for Revit- a cloud-based system 
that uploads the central model on cloud. This can be used by 
anyone from anywhere and improves communication and 
collaboration for project success.

12www.united-bim.com



• Always keep your Revit software package updated. Quarterly minor 
updates and annual updates come with critical patches and fixes for 
better user experience.

• Use the same version of Revit throughout your company/team. Revit 
is not backward compatible which can prove to be a hindrance for 
streamlined communication in case you are not using the same 
version.

• Never work directly on the central model without creating a local 
copy. Always make sure to open any file from the File menu by 
checking ‘Create New Local’ option.

REVIT BEST PRACTICES

13www.united-bim.com



Guidelines for Outsourcing BIM
Key Takeaways for AEC Professionals

FEATURED BLOGS

What is COBie?
How it is streamlining data collaboration 
between AEC professionals

What is Clash Detection in BIM? 
Process, Benefits and Future Scope in Modern 
Day AEC industry
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Some common Revit keyboard Shortcuts  
From  C:\Program Files\Autodesk Revit <version 
number>\Program\KeyboardShortcuts.txt 

This is the majority, there are others, but I try to keep that 
list down to one page so that it can be printed and taped 
to your monitor… 
; Settings menu 
"SU" menu:"Settings-Sun and Shadows Settings" 
"UN" menu:"Settings-Project Units"" 
Window menu 
"WC" menu:"Window-Cascade" 
"WT" menu:"Window-Tile" 
; 
; snap overrides 
"SI" snapcode:"Intersections" 
"SE" snapcode:"Endpoints" 
"SM" snapcode:"Midpoints" 
"SC" snapcode:"Centers" 
"SN" snapcode:"Nearest" 
"SP" snapcode:"Perpendicular" 
"ST" snapcode:"Tangents" 
"SW" snapcode:"Work Plane Grid" 
"SQ" snapcode:"Quadrants" 
"SX" snapcode:"Points" 
"SR" snapcode:"Snap to Remote Objects" 
"SO" snapcode:"Snaps Off" 
"SS" snapcode:"Turn Override Off" 
; 
Revit Building features many preset keyboard commands 
to increase your efficiency: 
 
Selecting: Press If you want to  
CTRL Select multiple elements  
TAB Cycle through the prehighlighting of elements to 
select among ones that are close to one another. Note: If 
you are selecting multiple elements and need to use the 
Tab key, do not hold the CTRL key while pressing TAB.  
TAB Prehighlight wall faces or wall centerlines when 
placing dimensions  
TAB Toggle between selecting a curtain wall or a glazed 
panel in a plan view  
SHIFT+TAB Reverse the order in which TAB cycles 
through the prehighlighting of elements  
CTRL+A Select all rows in the Worksets dialog box.   
 
Snapping 
 
Press If you want to  
TAB Cycle through different snaps while creating walls 
and lines, placing components, or moving or pasting 
elements.   
SHIFT+TAB Reverse the order in which TAB cycles 
through different snaps. Pressing SHIFT+TAB once 
suppresses all snap points.   
 
File Management 
 
Press If you want to  
CTRL+O Open a project  
CTRL+P Print a page  
CTRL+S Save a project 
 

EDIT MENU 
MD  modify 
MV  move 
CO  copy (Cntrl-C) 
RO  rotate 
AR  array 
MM  mirror 
PR  properties 
DE  delete 
GP  group 
LO  lock objects 
SA Select all instances 
RE Resize 
PP Pin Position UP=unpin 
CS Create Similar 

VIEW MENU 
ZR  zoom in region 
ZO  zoom out (2x) 
ZF  zoom to fit 
ZE  zoom to fit 
ZA  zoom all to fit 
ZS  sheet size 
ZP  previous scroll/zoom 
 
F8  dynamic view dbox 
F5  refresh 

DRAFTING MENU 
DI  dimension 
EL  spot elevation 
GR  grid 
LL  level 
TX  text 
TG  tag 
RP  ref plane 
RT  room tag 
DL  detail lines 

More VIEW menu 
VP View Properties 
VG Visibility graphics 
VH category invisible 
Vi Other categories invisible 
HH Hide object 
HI isolate object 
HC hide category 
IC isolate category 
HR reset temp hide/isolate 
 

TOOLS MENU 
LW  linework 
PT  paint 
SF  split face 
AL  align 
SL  split walls and lines 
TR  trim/extend 
OF  offset 
F7 spelling 
MA match 

SHADE/WIREFRAME 
WF wireframe 
HL hidden line 
SD shade mode 
AG advanced model graphic 
 
other 
TL thin lines 
RR rendering raytrace 

ALTERNATES 
ZZ  zoom in region 
ZX  zoom to fit 
ZC  previous scroll/zoom 
ZV  zoom out (2x) 
VV visibility/graphics 
CC  copy 
 

File menu 
ER File-Editing Requests 
RL File-Reload Latest 
RW File-Reload Latest 
 

 MODELING MENU 
WA  wall 
WN  window 
DR  door 
CM  component 
LI  lines 
RP ref plane 

 
 
 



 
The following is gleaned from AUGI discussion forums: 
 
 
You can use Alt+Enter to edit the Element properties of almost everything.  
 
I found out today you can use Ctrl+Enter to toggle between Element and Type properties.  
 
Is this documented anywhere? 
Doesn't have to be ctrl-enter, just enter. 
Because by default when the Element Properties box comes up, the "Edit/New" button is highlighted, hitting enter brings 
up the Type Properties. Where the default highlighted button is "OK". Which takes you back to the Element Properties. 
 
You can verify this by clicking in any field first. Now neither Ctrl-enter nor Enter take you to the Type Properties. 
Also, if you hold the Delete key down, you can delete items one-by-one by clicking on them. It's often faster (although 
slightly more dangerous) than Click-Delete,...Click-Delete...Click-Delete.... 
 
 
 

 
Here are a few more. Some of them might be well known to most users, but there are always some users who haven't yet 
figured them out: 
 
- Arrow keys nudge selected object; Shift Arrow nudges 10 times as much. 
- When box selecting, if you drag left to right it selects only those elements entirely within the rectangle; if you drag right to 
left it selects elements that cross the rectangle as well. 
- Tab before selecting cycles through selection candidates. Tab while sketching cycles through possible snaps. This can 
be used to disable snapping in a particular case. Shift Tab cycles backwards. 
- SO disables all snaps for the next pick. Look in the snaps dialog box for other snap control keyboard tricks. 
- Tab to select a chain of lines or walls when none of them is already selected. To select only part of a chain, select a line 
in the chain, then mouse over another line in the chain, Tab, pick, selects the part of the chain connecting those two lines. 
- Esc key generally gets you out of the current command and back to the Modify tool (sometimes you need a few Escapes 
to get out several levels). 
- CS when an element is selected invokes the Create Similar command; this puts you into the appropriate tool to create 
an element like the selected one, and it sets up the Type to be the same as the original. 
- Typing a number while sketching a line finishes creating a line in the direction you were going with the specified length. 
Similar behavior for other commands such as Move -- the value typed goes into the "listening" temporary dimension 
(which is the one that is bold). 
- When entering a number in feet and inches, type the feet then a space then the inches -- no need to put " and '. (I didn't 
know this one myself for the longest time ). 
- Any time you are entering a number (such as in a temporary dimension) you can put an equal sign and then type an 
expression. For example, to sketch a golden rectangle with one side 10, set the other side to =10*(sqrt(5)-1)/2. Revit will 
calculate the expression and use that value. 
- If you are sketching many arcs or circles with the same radius, pick the Radius check box in the option bar and type the 
radius before sketching. This works even in the straight line tool for creating a rounded polyline. 
- Drag the witness line control on a temporary dimension to a different reference to control a different distance. 
- This one isn't keyboard related, but it's something that people often don't notice. If one or more elements are selected 
and you don't see any temporary dimensions, press Activate Dimensions from the option bar. 
__________________ 
Irwin Jungreis  
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101 BEST PRACTICE TIPS FOR REVIT MODEL MANAGEMENT 
 
 
The information given below is time sensitive as the technology and system requirements 
continually evolve. While I have made every attempt to validate all information, please verify and 
refer to the official Autodesk System Requirements posted on http://www.autodesk.com. Unless 
otherwise noted, all information applies only to the Autodesk® Revit® 2010 onwards. 
 
As the design team acclimates to a BIM workflow, the adoption of a company strategy for model 
management will become more important. Effective management is required to ensure that the 
model data remains coordinated, well-structured, and efficient. Secondary benefits include reduced 
errors; improved consistency between team members; and gains in production efficiency. The intent 
of this document is to convey best practices for managing a model authored using Autodesk® Revit®. 
 
1. HARDWARE 
 
It’s important that the hardware on which the Revit platform is running is up to at least the 
minimum system requirement set by Autodesk. 
 
To help users Autodesk has put together minimum system requirements for Revit 2008 onwards on 
both 32bit and 64bit systems. 
 
Link: System requirements for Autodesk Revit products. 
 
Check your Graphics Card is on the Autodesk Certified Hardware list. You can check by clicking this 
Link: Find Recommended Hardware. 
 
Check this Link for system requirements (for Revit 2018) and any updates with regards to new 
requirements. 
 
 
2. GENERAL MANAGEMENT (MEMORY) 
 
It is a good idea to close the program at least once a day (ideally when you take a lunch break) and 
before undertaking a memory intensive task, such as rendering, exporting, printing etc. Autodesk 
also recommends before performing any of the operations listed above, performance can be 
improved by reducing memory usage if you do the following: 
 

 Close other applications currently running (but not being used). 
 

 Shutting down or restarting your machine at the end of the day releases system resources. 
 

 Turn off shadows for all printed views if not absolutely necessary or required for that view. 
 

 Detach local copies from central before printing and exporting to limit network resources 
and reduce project chatter between local and central files (use this tactic with caution 
because changes subsequent to detachment cannot be saved to the central file). 
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3. GENERAL GUIDELINES 
 

 Images: reduce image size before importing into Revit. 
 

 Once you are done using a design option, ensure that you accept the primary (to become 
the main model) and delete all other irrelevant options. 

 
 Create a Central file in the WIP folder. 

 

 Always work in a local file each time you go into the file by checking ☑ creating a new Local 
each time you go into your project. 

 
 Leave a note in the comments box upon synchronisation when a major change is made. 

 
 Audit the Revit model once or twice a week (minimum). 

 
 Restart Revit over lunch to reset cache, and reduce ‘lag’ when using Revit. 

 
 Compacting the local file at the end of the day (see your BIM Lead/Manager). 

 
 Pin an element to keep it from moving (do not use excessively as this slows Revit). 

 
 Link CAD files instead of importing them - choosing “current view only” when linking. 

 
 Zoom into the part of the view where you are working. This will reduce display calculations. 

 
 Start models utilising the walls and components embedded within the template. 

 
 Use Move command to move large numbers of objects, instead of dragging them. 

 
 Importing images in Revit: reduce the image size before importing. 

 
 Export rendered images to disk, instead of keeping them inside the project.  

 
 Perform rendering and walkthroughs in a separate file and then link the project to that file. 

 
 Revit Updates: Install the newest builds of Revit and service packs (see your BIM Lead). 

 
 Each User within a team must be on the same build of Revit, otherwise corruptions occur. 

 
 Volume Calculations should automatically be switched off until exports are required. 

 
 Minimise number of Levels within the models and omit levels not used. 

 
 BIM Lead/Manager must perform periodic project/model health checks and audits. 

 
 Continuously meet with Revit users, discuss problems and implement suggestions. 

 
 Collate and document problems and challenges (set up a lessons learned register). 

 
 Continuously update standards and train people on changes and lessons learned. 



 

101 Best Practice Revit Tips V2.0   Page 5 of 10 
 

4. PROJECT TEMPLATES 
 
Project Templates should be employed & configured on all projects to ensure consistent project 
development, output, functionality and aesthetics by the BIM Manager/BIM Coordinator. More than 
one Project Template may be produced to separate content per project type. Eg. Healthcare, 
commercial, residential etc. 
 

 Templates should include and define Annotation Styles, Dimension Styles, Fonts, 
Import/Export Settings, Line styles, Line Weights and Line Patterns. Object Styles. Tags. 
Avoid populating project templates with an excessive number of families that may or may 
not be useful for every project. Favour a minimal rather than a comprehensive template 

 
 Drafting Views: Consider creating a standard drafting view for Standard detail sets e.g. 

window/door jamb details. Do not use AutoCAD for this exercise.  
 

 Details should be developed with the 3D model in the background. Ensure detail items i.e. 
detail lines are locked to the 3D geometry.  

 
 When setting a template, don’t over load it with families. Include the 5-10 most commonly 

used types for System Families (e.g. Walls). 
 

 Limit Component Families (e.g. Doors, Windows) to those that are used on nearly every 
project. 

 
 Schedules: Set up and pre-format schedules for Windows, Doors, etc. so that they will fill 

themselves out when content is added to the model. 
 

 For all preloaded content, ensure that parameters have been assigned so that schedules and 
keynotes will fill themselves out. 

 
 Title blocks: Include common sheet sizes (e.g. A0, A1), company logo, etc. Include examples 

of sheets that are consistent from project to project (eg. Cover sheet, floor plan, ceiling plan, 
detail sheets etc). 

 
 The standard template only needs to have the general/standard elements which would be 

used on most if not all projects. Then anything else can be added when or if required. 
 

 Set up appropriate View Template’s for drawing sheets (eg. Shaded Elevations/detailed Shop 
drawing Elevations, Sections). 

 
 
5. LINKING & IMPORTING 
 

 Minimise the number of linked or imported files in a Revit model. 
 

 Only import ‘cleaned’ and un-exploded AutoCAD dwg files into Revit, making sure all 
unnecessary layers and blocks are deleted, purged, audited beforehand. 

 
 Think about  what’s in the  dwg file before you insert the file into Revit and avoid 

unnecessary data such as hatching of AutoCAD specific line-work such as construction lines. 
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 Avoid exploding geometry imported from dwg files, as exploding will creates more elements. 
 

 Only link essential dwg files into necessary views. Remove links when not required any more. 
 

 Switch off visibility of 2D AutoCAD dwgs in perpendicular/elevation views. A 2D dwg file 
lined to a plan view will show as collinear lines in elevation, causing performance 
degradation. 

 
 Unload all links if they aren’t being used and reload them when required. 

 
 When working on large projects think about breaking the model into separated project 

models and then linking them into one single central file. 
 

 Do not link or import unnecessary files or families into your model. 
 

 When working in a linked file environment use Wireframe or Shading display modes. 
Wireframe and Shading modes can be 3times faster than the Hidden Line or Shading with 
Edges modes. 

 
 
6. VIEWS 
 

 Unused Views: Name it or delete it. In addition, use the Close Hidden button to close views 
that are not currently being edited. 

 
 Minimise the view depths to avoid showing unnecessary information. 

 
 Close hidden views, as any changes to the model done not only updates the current view but 

will also update any views affected by those changes. 
 

 Turn off shadows in views and when printing unless required for the final output drawings. 
 

 When working in a 3D view, don’t have shadows switched on, it will slow the model down as 
it will have to redraw the shadows every time you change the model or move/rotate the 
view. 

 
 When  navigating  within  a  3D  View, use  a  section  box  to  zero  in  on  the  area  you’re  

working. This reduces the amount calculations Revit needs to perform in the background. 
 
 
7. FAMILIES 
 

 Parametric families consume more resources than static families, but they provide flexibility 
that may reduce the number of families that need to be loaded into a project—finding a 
balance is key. 

 
 Face-based families consume less resources than those that cut their hosts. 

 
 It may be unnecessary to model 3D geometry in all families, especially if the family only 

appears in one or two orientations (e.g. plan, elevation). However, 3D geometry may 
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actually be more efficient than the extensive use of 2D detail elements. Practice both 
techniques to optimize families. 

 
 Use In-Place families  sparingly. 

 
 Create family components instead of in-place families for repetitive components. When an 

in- place family is copied, it makes an entirely new entity each time, as opposed to 
referencing the type information from the first instance. 

 
 Limit the use of detailed/nested/parameterised families to necessities only. 

 
 Families require fewer resources than groups. Use families instead of groups where possible. 

Groups are very powerful, but updating large quantities of group instances consumes 
significant computing resources. 

 
 When creating a family in 3D – think, does it really need to be 3D? If it’s only going to be 

shown 2D then you don’t need a 3D view. Creating a 2D version of a family is 20% smaller 
than the 3D version, so if you had multiple families in a project the 3D version would 
increase the model size considerably. 

 
 Check the ‘reveal constraints’ button on the view control bar (located at the bottom of the 

Revit screen) to ensure nothing is locked that shouldn’t be locked. 
 

 Minimise over-complicated components – Remember…KISS! (Keep It Simple Stupid). 
 
 
8. OVERMODELLING 
 

 Complex geometry: Improve performance by ungrouping and removing the parametric 
associations of copied objects. 

 
 Minimise multiple parametric relationships. 

 
 Multiple constraints: Minimise the constraints within a model. 

 
 Don’t use 3D geometry when detailing is sufficient. 

 
 Minimise 2d lines, annotation, complexity of geometry and regions. 

 
 Cut down on constraining within the model. 

 
 Unnecessary locking of elements. 

 
 Use Groups sparingly. 

 
 When creating detail views, model hatches with filled regions rather than lines. 

 
 Limit joined geometry in your model; don’t just join something – think, does it need to be 

joined? 
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 Levels in Elevation: Avoid using levels to indicate every vertical reference in elevation (e.g. 
window head and sill elevations); such a technique will require a user to hide irrelevant 
levels in every elevation and section view. Develop and use Spot Elevation tools to label 
these items. 

 
 Railings: Model railings to provide adequate detail for general use (elevations, plans), but 

avoid the temptation to model all details within the railing. Add two-dimensional details 
where required (plans, sections, elevations, details) to fully describe railings. 

 
 Volumes: Setting the Area and Volume Computation option to calculate Areas only may 

improve performance; however, this reduces much of the analytical functionality of Revit 
MEP. 

 
 Consider breaking up the model into multiple files, especially on large models. For example, 

if you have a building with multiple wings, model those in separate models and link them 
into the central model. 

 
 Close all other applications currently running in the background (but not being used).  

 
 
9. SPLITTING THE REVIT MODEL 
 
General recommendations, per Autodesk: “Consistent customer practice is to break up a large 
model into multiple files of about 160 MB each for 32-bit Revit or 200 MB for 64-bit Revit, then link 
together the resulting project files. Such a procedure will work best if the user can work on one file 
while the other links are unloaded for a majority of the time. 
 
Engineering consumers of architectural models may have to maintain one or more constantly loaded 
links, which may affect model size estimation and thresholds for those disciplines.” 
 
The decision to split a model should be made early in the design process, ideally in the Pre- Design or 
Schematic Design Phase with all consultants aware of this decision and its ramifications. Splitting the 
model later in the design process adds significant time and cost. Specific conditions that may trigger 
a multiple-model project include: 
 

 Separate buildings (a “campus” project where each building would be a separate model, 
linked together on a “master site plan” project); 

 Collaboration between geographically disperse project teams (A single building being 
worked on by multiple offices that are not on the same WAN); 

 Unusually large files (after all other model management practices have failed, because of the 
particular needs or scope of a project, it may still not be possible to keep the model to a 
reasonable size); and  

 Phased projects where there is a natural and specific split of the design and/or construction. 
 
Where file size is the primary factor, model splitting should be considered a last resort and is not to 
be undertaken lightly. All model management and modelling best practices methods and procedures 
should be exhausted before model splitting is undertaken. If a firm encounters project types and 
sizes that require this approach on a consistent basis, I strongly recommend working in a 64-bit 
environment with an appropriate hardware specification in accordance with Autodesk system 
requirements (or higher). 
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10. WORKSETS & WORKSHARING 
 

 Use Worksets to allow multiple users to work on a single model at any one time. This is a 
valuable tool which can help with workflow as different users take ownership of different 
elements within the model, allowing them to edit those elements before relinquishing them 
back to the central file. 

 
 When creating a Workset, leave the Visible by default in all views option selected. Clearing 

this option can render the Workset completely invisible and problematic in multi-discipline 
workflows where feature visibility can be of paramount importance. 

 
 It’s a good idea to create a new local file from the central model every few days. 

 
 Regularly compact the central and local files to reduce file size and memory usage. 

 
 Put linked models on their own workset. 

 
 
11. REVIT WARNINGS 
 

 Minimise/fix warnings. Less than 10 is ok, more than 1000 is not! (keep below 10% file size). 
 

 If Revit flags up with a warning as you’re modelling don’t just ignore it, as later on down the 
line you may find out that something has gone wrong. 

 
 
12. PURGE & AUDIT 
 

 Just like in AutoCAD, it is a good idea to run a Purge and Audit regularly to help reduce the 
files and reduce the chances of the file becoming corrupt. 

 
 Purge unused families and groups regularly (keep in mind you don’t purge elements you may 

need later!). 
 
 
13. FILE MAINTENANCE 
 
The following are recommendations for file maintenance mirroring those provided by a client with 
significant Revit project experience2. For small projects, this file maintenance schedule may be 
largely unnecessary, while it may need to be accelerated to keep a very large model manageable. 
Also note that these maintenance procedures may be applied to files received from consultants to 
ensure optimal performance. 
 

 Periodic File Maintenance (e.g. every sheet set issue): In addition to weekly maintenance 
tasks, perform the following steps; 

 Audit the central file; 
 Create a backup of the central file; 
 Create a new central file; and 
 Have all users create new local files from this central file. 
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Every Two Weeks: In addition to weekly maintenance tasks, perform the following step: Create a 
backup of the central file. 
 
Weekly: 

 Audit the central file; 

 Perform a Coordination Review, if using Revit to maintain coordination with consultants; 

 Perform an Interference Check, if using Revit to detect collisions; 

 Review and resolve warnings; 

 Delete unused or redundant views; 

 Purge unused elements that will not potentially be used in later phases of the project; and 

 Compact the central and local files. 
 
Daily: 

 Audit local files upon opening them; and 

 Compact local files when closing them for the day.  
 
Backups & Archives: 

 At each issue date, or as required, use the Detach from Central option to create an 
independent, archive-ready central  file. 

 Backups can be generated via the same process, but this is generally unnecessary, as each 
user’s local file can be considered to be a backup file. If a central file becomes corrupt, it is 
often most efficient to convert the most-recently-saved local file for that project into a new 
central file, rather than attempting to recover a backup file that may be obsolete. 

 
 
14. FINAL NOTE: 
 
A model Audit should be undertaken on a monthly basis with a check list and images, by creating a 
standard Model Audit Template/Report. Make sure all Revit users are properly trained on how to 
use Revit, making sure they follow correct company protocols and best practice method listed 
above. And at the start of all new projects, run kick-off BIM/Revit sessions. 
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